Retrospective Theses and Dissertations (RTD)

Processing SOP

RTD Process: Table of Contents

<table>
<thead>
<tr>
<th>Specialist</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Imaging Specialist</td>
<td>2</td>
</tr>
<tr>
<td>STEP 1: DOWNLOAD THESES FROM SERVER</td>
<td>2</td>
</tr>
<tr>
<td>STEP 3: PROCESS IMAGES</td>
<td>4</td>
</tr>
<tr>
<td>STEP 4: PROCESS SUPPLEMENTARY FILES</td>
<td>5</td>
</tr>
<tr>
<td>STEP 5: SETUP IMAGES FOR FDA</td>
<td>9</td>
</tr>
<tr>
<td>STEP 6a: Compress PDF for Digital Commons</td>
<td>9</td>
</tr>
<tr>
<td>Metadata Specialist</td>
<td>11</td>
</tr>
<tr>
<td>STEP 6b: CREATE PDF and PDF-A</td>
<td>11</td>
</tr>
<tr>
<td>STEP 7: UPLOAD METADATA INTO FIU DIGITAL COMMONS (ETD)</td>
<td>14</td>
</tr>
<tr>
<td>STEP 8: ENTER METADATA INTO ETD (DIGITAL COMMONS)</td>
<td>16</td>
</tr>
<tr>
<td>STEP 9: ENTER METADATA INTO METS FOR FDA</td>
<td>17</td>
</tr>
<tr>
<td>STEP 10: MOVE FI FOLDERS</td>
<td>21</td>
</tr>
<tr>
<td>STEP 11: SEND LIST OF 10 THESES TO DIGITAL ARCHIVIST FOR FDA</td>
<td>22</td>
</tr>
<tr>
<td>STEP 12: ADDING DCC LINK TO ALEPH CATALOGING FOR RTDS</td>
<td>23</td>
</tr>
</tbody>
</table>

*Edited 7/1/2015*
RTD Processing

Imaging Specialist

The RTD Digital Imaging Specialist downloads and processes the images for the digital form of the theses. Any supplementary materials, contained in a CDROM or DVD, are also processed by the Imaging Specialist.

STEP 1: DOWNLOAD THESSES FROM SERVER.

The UTS department uploads scans to the FTP DATA server. Files must be moved from the FTP DATA drive to the RTD_current folder on the Production drive.

1. Thesis files are downloaded from FTP DATA server, located at:
   smb://dpantherfi01.ad.fiu.edu/FTP_DATA (MAC)
   \\dpantherfi01.ad.fiu.edu\FTP_DATA (PC)
   a. Files will be in the DCC folder, typically organized by batch (see UTS batch tracking spreadsheet for batch #s)
   b. Files received will have the following structure:
      i. FI ####### (thesis directory)
         i. PDF_SM_FI#### (small PDF created from TIFFs - no OCR)
         ii. Source_FI#### (RAW scan images)
         iii. TIFF – FI#### (TIFFs created from RAW scan images)
   c. Track Download
      i. Use tracking spreadsheet UTS_batch_FL_tracking.xlsx in the RTD project documentation folder under the RTD_current:
      ii. Check under “to download” for thesis on server but not downloaded
      iii. Check under “downloaded” for theses downloaded to RTD_current
      iv. Use Excel pull down filters to check status
   d. Copy file(s) to the dPanther Production server’s RTD_Current Folder:
      smb://dpantherfi01.ad.fiu.edu/Production (MAC)
      \\dpantherfi01.ad.fiu.edu\Production (PC)
      i. Drag & drop files to production folder window into RTD_current
STEP 2:  CHECK FI NUMBERS.

After the thesis files are downloaded, the FI numbers must be checked to ensure that the FI number used in the name of the thesis files matches the number assigned by DCC. FI numbers may be checked using the DCC tracking site or the RTD Project spreadsheet.

1. Look for the title on the book cover:
   a. In the PDF_SM_FI######## folder, check the PDF created from TIFFs (no OCR)
   b. OR look at the first image in the TIFF – FI######## folder.
2. Digital Collections Tracking Site:
   a. https://poseidon.fiu.edu/dcc/
   b. Logon username: Andrew & password: Andrew
   c. Search for the FI number or for “Retro Theses and Dissertations”
RTD Processing – Imaging Specialist

3. RTD Project spreadsheet:
   a. *RTD_current* > RTD MARC2 Project Data.xlsx
   b. Search for the Fl number

![RTD MARC2 Project Data](image)

4. Errors with the Fl number should be reported to the UTS personnel.
   a. Adobe Bridge may be used to rename files
      i. Select the files to be renamed
      ii. Under the tools menu, select “Batch Rename…”

**STEP 3: PROCESS IMAGES**

The thesis files are then processed for OCR. Text-only pages are converted to black & white. Pages are rotated when necessary to improve OCR. Color pages are down sampled from 400dpi to 300dpi. Pages with images that are not in color are converted to grayscale and down sampled from 400dpi to 300dpi.

1. Reviewing and prepping the files for the OCR process:
   a. Look through the small PDF for any errors:
      i. Discoloration, distortion, page creases, crooked lines, unreadable text.
      ii. If the small PDF is damaged, look through the Tiff files in the *TIFF – Fl############* folder.
   b. Check that all pages are present by making sure that pagination is complete.
      i. Verify there are no missing page #’s.
   c. Correct mistakes that can be corrected in Adobe Photoshop.
      i. Correct levels and curves adjustments.
      ii. Process the RAW pages in *Source_Fl############* (RAW scan images) if there is an error in the TIFF.
   d. More serious errors need to be reported to the Imaging Dept. and re-scanned.
      i. Multiple pages have errors or pages are missing.
2. Prepare the TIFF files.
   a. Create a folder called TIFF2OCR for the processed files to go into for OCR.
   b. Sort TIFFs for: Signatures, Color, Grayscale, Rotate, BMP (B&W bitmapped text), and OMIT (covers, blank pages)

3. Process the TIFF files:
   a. White out signatures for identity protection manually in Photoshop.
   b. Create a Photoshop Action for converting the files to pure B&W bitmapped text files or 300dpi color/grayscale files.
   c. Create a Photoshop Action to rotate the files, if necessary.
   d. Run the Actions as a Batch Processes to all the pages of that particular thesis.
   e. Files processed into the TIFF2OCR folder.

4. Files for OCR:
   a. Files must be in the TIFF2OCR folder.
   b. The main FI############ folder must be in RTD_current for the PrimeOCR jobs.

For more detailed instructions, refer to the RTD-ImagingPrep.docx in the RTD_current folder on the Production share on the DCC file server, libdcc02 and on SharePoint.

STEP 4: PROCESS SUPPLEMENTARY FILES

Some theses have supplementary files on CDROM or DVD, or inserts such as flyers that must be scanned separately. Audio disks must be ripped to WAV files for FDA and converted to MP3 files for Digital Commons.

1. Process supplementary Materials:
   a. Create a folder called supplementary – FI############
   b. This file will host all supplementary material for the thesis with FI############

2. Processing an audio CD in Adobe Audition:
   a. Insert the CD into the drive.
   b. Use Adobe Audition to rip the audio tracks to .WAV files:
      i. Under the file menu select “Extract Audio from CD”
ii. Save the WAV files to *supplementary – FlYYYYYYYY*

c. Use Adobe Audition to convert WAV files to MP3 files:
   i. Drag and drop files to the Batch Process tab
   
   ![Batch Process Tab](image1.png)

   ii. If there is no Batch Process Tab, select Batch process under the Window menu.

   iii. Click on “Export Settings…”

   iv. Setup the Export Settings:
RTD Processing – Imaging Specialist

a. Select MP3 Audio as the format and check settings as below:

![Export Settings](image)

v. Click Run to process files:

![Adobe Premiere](image)

vi. Rename audio tracks to “FI############_Track#”

3. Processing video files in Adobe Premiere:
   a. Start Adobe Premiere and create a new project using the default settings.
   b. Under the File menu, select import to bring a file into the project.
   c. Click on the video and select “Get Properties for Selection” under the File menu.
      i. If the file does not match one of the high confidence level formats for FDA (see step 5), it must be converted.
         1. AVI or MOV uncompressed using the Motion-JPEG codec.
ii. If the video is uncompressed, it should be compressed for the FIU Digital Commons to reduce file size for download access.

d. Under the File menu, select Export:
   i. For a QuickTime movie compressed using H.264, the following will convert it to Uncompressed Motion-JPEG A.

   ![Video codec settings](image)

   e. In the supplementary files folder, separate FDA materials into a separate folder called FDA.
      i. This highlights which materials go into Digital Commons (ETD).
STEP 5: SETUP IMAGES FOR FDA

Image files that will be preserved are copied for FDA ingest. The FDA folder may not have any sub-folders (i.e. flat file structure). All files should be in the FI number folder.

Acceptable FDA formats are listed in this document: https://fclaweb.fcla.edu/uploads/recFormats.pdf.

File must be in a high confidence level format for optimal long-term preservation.

1. Prepare the FDA folder:
   a. Create a FI######## folder for the FDA (may be done as part of the METS batch process – see batch processing METS files for further instructions)
   b. Copy supplementary files from Supplementary - FI######## to the corresponding FI######## folder in the FDA_RTD.

2. The folder requires the PDF/A formatted PDF to be complete (see STEP 6).

STEP 6a: Compress PDF for Digital Commons

For documents and theses that are primarily 8 bit color or grayscale, additional processing in Acrobat may be required to reduce the file size for the final PDF. FIU digital Commons thesis uploads should ideally be less than 15MB in size. If the PDF file for the thesis in PrimeOCR (see step 6b) is still over 15MB in size after image processing, Adobe Acrobat will be used to optimize the PDF.

1. Acrobat Optimization:
   a. Open the PDF file in Acrobat.
   c. This will open a Document processing sidebar:

   d. Click on “Optimize Scanned PDF” to access the Optimize Scanned PDF settings:
      i. Select “All Pages”
RTD Processing – Imaging Specialist

ii. Check “Apply Adaptive Compression”
   1. Set Color/Grayscale to “JPEG2000” and Set Monochrome to “JBIG2 (Lossy)”
   2. Slide the quality bar to the middle between Small Size and High Quality.
      a. As the slider moves towards small size, text images will be converted to bi-tonal.
   3. Uncheck “Make Searchable (Apply OCR)” for PDF files created in PrimeOCR (Prime applies OCR)

iii. Click OK.

iv. If Acrobat detects pages that are already optimized, check “Apply to all compressed pages” and click OK.

v. Save the optimized file under another file name, File > Save As > FI#######-op. as to not overwrite the PDF file.

Note: Adobe Acrobat Pro has a number of tools to assist with analyzing and processing PDFs. However, processing scanned images in Photoshop provides more control over options such as conversion of color/grayscale images to a lower resolution (DPI) or images of text to Bitonal (Black/White, 1bit). Acrobat processing is best used for an existing PDF such as on created by PrimeOCR or for images scanned into Acrobat.

For more detailed instructions, refer to the RTD Create PDF.docx in the RTD_current folder on the Production share on the DCC file server, libdcc02 and SharePoint.
RTD Processing

Metadata Specialist
The Metadata Specialist collects and enters descriptive metadata, uploads thesis materials, and generates preservation metadata.

STEP 6b: CREATE PDF and PDF-A
PrimeOCR provides the best OCR by polling 6 OCR engines. For documents and theses that are primarily, text, PrimeOCR also provides efficient JBIG2 compression (which only applies to black and white images/pages). For theses & documents that are primarily 8 bit color or grayscale images, Acrobat optimization provides an efficient JPEG2000 compression that creates much smaller files of a good quality (see Step 6a). The Prime OCR program is run on the DGLWRK05 computer. PrimeOCR uses job files for Batch processing.

For more details, refer to the RTD Create PDF.docx in the RTD_current folder on the Production share on the DCC file server, libdcc02 and SharePoint.

Prime OCR Processing:

Batch processing through Script:

1. Open the program:
2. Move the created job files to C:\Prdev\Job
   a. Remove other job files from C:\Prdev\Job.
   b. RTD Job files are created by a script and are kept in the C:\Prdev\Job\to-do folder on DGLWRK05.
   c. Job file names are in the format, FI###.job
3. Running the Jobs:
   a. After the job file has been moved to C:\Prdev\Job, click “Play”: Prime OCR will run the job you just created.
   b. Folders must be in the right file and named correctly in order for this script to work.
c. Select the Output tab, check PDF, and click on Details.

iii. Settings for PDF
d. Rename the PDF files after each run (see next page).

4. File processing after OCR:
   a. PDF files are created using the folder name: TIFF2OCR.pdf
      i. rename PDF (see 3.b.iii) to FI####.pdf
      ii. Open pdf in Adobe Acrobat and save as PDF/A
      iii. Rename the PDF/A-1b file to FI####_pdfa.pdf
   b. Quality check the PDF file and give feedback to imaging specialist as needed.
   c. Move completed jobs to C:\Prdev\Job\done

5. DGLWRK05 File structure for PrimeOCR jobs
   a. C:\Prdev\Job\
      i. C:\Prdev\Job\cmd-to-create-jobs (script to create jobs)
      ii. C:\Prdev\job\done (location of jobs files that have been run)
          1. C:\Prdev\Job\done\batch# (location of job files by batch)
      iii. C:\Prdev\Job\to-do (location of jobs files to be run)
          1. C:\Prdev\Job\to-do\batch# (location of job files by batch)

6. Copy files for upload to the FDA:
   a. Copy FI####.pdfa.pdf to the corresponding FI#### directory in the FDA_RTD folder in RTD_current.
   b. For upload to the FDA, the FI#### directory in the FDA_RTD folder should contain:
      i. FI#### (thesis directory)
         1. FI####.pdfa.pdf (outputted PDF/a with OCR)
         2. FI####.xml (METS files)
RTD Processing – Metadata Specialist

3. Supplementary files from *supplementary – Fl############*
   a. This will be done by the Imaging specialist (see Step 5)

**STEP 7: UPLOAD METADATA INTO FIU DIGITAL COMMONS (ETD)**

RTD theses are entered on FIU’s Digital Commons under FIU Electronic Theses and Dissertations (ETD). Until thesis authors are contacted for their permission to electronically distribute the theses, RTD theses will be entered as Metadata-only and restricted to on campus network access.

For more details, refer to the **RTD ETD DigitalCommons.docx** in the **RTD_current** folder on the Production share on the DCC file server, libdcc02 and on SharePoint.

1. Created the Excel upload spreadsheet:
   a. Click on the ETD tab in the RTD project spreadsheet (RTD MARC2 Project Data.xlsx) in the **RTD_current** folder.
   b. Filter for the FI#'s of the thesis metadata to be imported
   c. Copy the selected rows from the ETD tab in the RTD project spreadsheet
   d. Paste as values into the RTDimport_ETD.xls spreadsheet (in **RTD_current**).
   i. RED fields must have entries.

<table>
<thead>
<tr>
<th>title</th>
<th>fulltext_url</th>
<th>keywords</th>
<th>abstract</th>
<th>author1_fname</th>
<th>author1_mname</th>
<th>author1_lname</th>
<th>author1_suffix</th>
</tr>
</thead>
</table>

2. Upload into Digital Commons.
   a. Click on Batch Upload Excel and select the RTDimport_ETD.xls spreadsheet (in the **RTD_current** folder).

   ![Batch Upload](image)

   ![Note: Please verify spreadsheet metadata before uploading - batch submissions are automatically queued for posting.](image)

   b. Click on Upload to enter the data in the spreadsheet and create ETD entries for theses.
   c. Entries initially will be “Queued for Update” (until the Digital Commons is updated by clicking on “Update Site” under “Manage Submissions”).
3. **Set Metadata Only:**
   a. Under “Manage Submissions”, click on View revisions to set Metadata Only for each thesis.
   b. Under “Download link behavior”, select “No full-text: Metadata only”, and click “Save”.

4. **Set Thesis to Restricted Access:**
   a. Click on “Revise Submission” to restrict access to on campus networks for each thesis.
   b. Select “Restricted” from the pull down menu under “Availability”:
   c. Scroll down to the “Reason for Update” and click on “Submit”.
RTD Processing – Metadata Specialist

5. Under “Manage Submissions”, click on “Unassigned” under “Administrator’ to assign an administrator for each thesis:

   a. Select a name, and click “Assign”. The assignee will receive an email.

6. Update Digital Commons by clicking on “Update Site” under “Manage Submissions”.

STEP 8: ENTER METADATA INTO ETD (DIGITAL COMMONS)

After the metadata is uploaded into Digital Commons, the Metadata Specialist adds the Date of Defense, Advisor names, and Abstract from the thesis PDF, FI#####.pdf (see Step 6b). In addition, supplementary files from the supplementary – FI##### are uploaded if the folder is present (see Step 4).

For more details, refer to the RTD ETD DigitalCommons.docx in the RTD_current folder on the Production share on the DCC file server, libdcc02 and on SharePoint.

1. Enter Metadata into Digital Commons:
   a. Click on “Revise Submission” to restrict access to on campus networks for each thesis
   b. Enter Date of Defense, Advisor names, and Abstract from the thesis PDF.
   c. Upload the thesis PDF
RTD Processing – Metadata Specialist

i. Click on “Choose File” and select the thesis PDF., FI############.pdf from the FI number folder

Upload file

- Upload file from your computer
- Import file from remote site
- Link out to file on remote site

Please upload the full text of your submission:

| Choose File | No file chosen |

ii. d. Click on “Submit” to enter the metadata.

2. Upload Supplementary materials:
   a. Under Manage Submissions, Click on Supplemental Content:

   b. Click on “Choose file” to select the files from the supplementary – FI############ folder. Uncheck the “Show” checkbox until permissions are received from the thesis authors. Click “Save” when all files are listed.

STEP 9: ENTER METADATA INTO METS FOR FDA

The Florida Digital Archive (http://www.fcla.edu/digitalArchive/index.htm) is used to host the TIFF masters, supplementary materials, and metadata files generated for each thesis. The FDA provides long-term preservation for digital. The SobekCM METS editor is used to create a METS description file for folder to be submitted to the FDA.

For more details, refer to the RTD METS Editor manual.docx in the RTD_current folder on the Production share on the DCC file server, libdcc02 and on SharePoint.

1. METS File Creation:
   a. Select “Create New METS file” to add a METS file to the Thesis folder:
b. Navigate to the thesis directory
c. Select the thesis folder identified by FI number) & click OK.

d. In Acrobat, check that the PDF in the folder is a PDF/A by looking for:

The file you have opened complies with the PDF/A standard and has been opened read-only to prevent modification.

2. Select the PDF/A file and supplementary files (audio, other documents) & click continue
   a. Do not select systems files such as Thumbs.db or .DS_Store
b. On the Materials Information tab, enter thesis metadata from:
   i. The RTD Project spreadsheet
   ii. The thesis PDF
   iii. ETD (Preferred Citation).

3. Click on the METS Information tab and enter the METS header information:
4. Click on the ETD tab and enter ETD information:

5. Click on FCLA/PALMM to enter information for the Florida Digital Archive:
   a. FDA project code is **ETD**

6. Click on Structure Map to add page numbers:
   a. On the Structure map tab:
      b. Right-click on the first page and select “Edit Page Label”, enter 1 and click OK.

7. Click on “Finish” when done and the METS file with an extension of .xml will be created in the FI number directory for the thesis.
RTD Processing – Metadata Specialist

8. Track Status:
   a. Use tracking spreadsheet UTS_batch_FI_tracking.xlsx in the RTD project documentation folder under the RTD_current:
   b. Check under “Processed” for theses with METS files.
   c. Use Excel pull down filters to check status.

STEP 10: MOVE FI FOLDERS

The RTD_current folder is used to host materials for the RTD project. The file structure is designed to provide status for the theses indicated by the folder where they reside.

Two sets of FI number folders are maintained for the theses. The FDA_RTD folder contains materials for long-term preservation at the DCC and the FDA. The FI_for_ETD folder contains the working files as downloaded from the SFTP server. The working files in the done folder under FI_for_ETD may be deleted when an FI # is officially complete.

RTD_Current folder structure:

1. **FDA_RTD**
   1.1. **FDA_ready_to_ingest**
   1.1.1. **FDA_ingested**
   2. **FI_for_ETD**
   2.1. done
   3. **RTD project documentation**
   4. **Send back to UTS**
   5. **Supplementary materials hold**

   (contains theses needing METS processing)
   (theses ready to upload to FDA)
   (theses already uploaded to FDA)
   (theses with pdf ready for Digital Commons)
   (theses entered into Digital Commons)
   (documents, templates and batch files)
   (theses with errors requiring a rescan)
   (theses requiring supplementary materials to be scanned/ripped)

As steps in the RTD process are completed, files are moved to subfolders:

1. Move FI folder to FI_for_ETD:
RTD Processing – Metadata Specialist

1. After creating the pdf file for the thesis
2. Move the FI#### folder from RTD_current to FI_for_ETD
   - This indicates that the thesis is ready for upload to digital commons
3. Move FI folder to done:
   - After entering metadata into Digital Commons (Step 8)
   - Move FI#### in FI_for_ETD to done
     - This indicates that the thesis has been uploaded to digital commons
     - Files in this folder may be deleted when the thesis has been uploaded to FDA
4. Move FI folder to FDA_ready_to_ingest:
   - The FI folder in FDA_RTD is created by the Imaging Specialist
     - Files in this folder or its subfolders may NEVER be deleted
   - When the METS files is created, Move FI#### in FDA_RTD to FDA_ready_to_ingest
     - This indicates that the thesis is ready to be sent to FDA
     - Files in this folder may NEVER be deleted
   - When the thesis is sent to FDA, move to FI#### to FDA_ingested
     - This indicates that the thesis has been sent to FDA
     - Files in this folder may NEVER be deleted

STEP 11: SEND LIST OF 10 THESES TO DIGITAL ARCHIVIST FOR FDA

Theses in the FDA_ready_to_ingest are ready to be sent to the FDA. A list will be emailed to the Digital Archivist with a list of ten theses for upload to the FDA.

1. Select the next 10 thesis in the FDA_ready_to_ingest
2. Email the list to the Digital Archivist
   - Fi numbers may be copied and pasted from the tracking spreadsheet UTS_batch_FI_tracking.xlsx in the RTD project documentation folder
3. Track Status
   - Use tracking spreadsheet UTS_batch_FI_tracking.xlsx in the RTD project documentation folder under the RTD_current:
   - Check under “sent to FDA” for theses sent to FDA by Maggie
   - Use Excel pull down filters to check status
STEP 12: ADDING DCC LINK TO ALEPH CATALOGING FOR RTDS

Open Cataloging Program in ALEPH500_SBFIPROD

Login with ALEPH User Name and Password.

Type in Aleph number (from RTD spreadsheet) in upper left hand corner and click arrow.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>030170140</td>
</tr>
<tr>
<td>008</td>
<td>930401s1992^<del>^xx^</del>^<del>^b^</del>^000</td>
</tr>
<tr>
<td>035</td>
<td>(OCoLC)27842787</td>
</tr>
<tr>
<td>040</td>
<td>FXG</td>
</tr>
<tr>
<td>090</td>
<td>a: RD771.8217</td>
</tr>
<tr>
<td>b: A32 1992</td>
<td></td>
</tr>
<tr>
<td>100-1</td>
<td>Abdel-Moty, Alma R.</td>
</tr>
<tr>
<td>245-10</td>
<td>Stated versus observed performance levels in patients</td>
</tr>
<tr>
<td></td>
<td>with chronic low back pain / by Alma R. Abdel-Moty.</td>
</tr>
<tr>
<td>300</td>
<td>iv, 57, [27] leaves ;</td>
</tr>
<tr>
<td></td>
<td>29 cm.</td>
</tr>
<tr>
<td>504</td>
<td>Includes bibliographical references (leaves 48-56)</td>
</tr>
<tr>
<td>650</td>
<td>Backache</td>
</tr>
<tr>
<td></td>
<td>Patients.</td>
</tr>
<tr>
<td>650</td>
<td>Intractable pain</td>
</tr>
<tr>
<td></td>
<td>Patients.</td>
</tr>
</tbody>
</table>

put cursor in after the 600’s and hit F6 (or go to Edit Text/New Field)

add the following fields (using F7 or Edit Text/New SubField to create new lines):

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>856-42</td>
<td>γ</td>
</tr>
<tr>
<td></td>
<td>Also available online. Click here!</td>
</tr>
<tr>
<td>u</td>
<td><a href="http://digitalcommons.fiu.edu/etd/###">http://digitalcommons.fiu.edu/etd/###</a></td>
</tr>
<tr>
<td>5</td>
<td>FMFIU</td>
</tr>
</tbody>
</table>
Click Save (Save on Server and Local Drive – also Ctrl L)

And CONTINUE

(Any error messages in Green are OK – click override!)
Update the RTD spreadsheet to indicate the links have been added (column titled “link in Aleph Catalog”)

TIPS:

Create Macros as needed by using Macro Express. A Macro exists to create the 856 fields. Open the aleph.mex file in production/RTD_Current/RTD project documentation/SOP. It will assign a key to auto-populate everything but the final bit of the URL.